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About eFlip Standard

eFlip Standard provides a full digital publishing and
distribution solution that allows you to convert

PDF, Microsoft Office (.docx;.xIsx;.pptx) and OpenOffice
document into digital publications with realistic
page-flipping effect, on and offline. You can

publish unlimited publications online and share it with
others via email, social website, and even distribute it on

CD-ROM, all without paying royalties.

eFlip Standard can be downloaded and installed on a PC
or Mac computer. So that you can create as many
publications as you want and control everything
including the whole production and hosting of your
publication in-house. With the eFlip's free online upload

service, We also host the flipbook for you.
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Note: This product is distributed on a "Try
before-you-buy" basis. All features described in this
documentation are enabled. The registered version
doesn't insert a watermark in your generated

page-flipping eBooks.

Product features

1. Convert PDF to Adobe®© Flash® based page-flipping eBooks.

2. Create unlimited digital publications form PDF, Microsoft Office and OpenOffice;
3. Easily and securely hosting with 5 GB free online publication storage account;
4. Host your 250+ eBooks and securely; share any publication instantly.

5. Offer Project Panel to easy open or save project.

6. iPad, iPhone & Mobile Phone, BlackBerry and Android Support (HTML5);

7. Batch convert multiple PDF files to a single or multiple page-flipping eBooks.
8. Import bookmarks (outline/table of content) with PDF.

9. Build-in 20+ pre-desinged templates help create professional flipbook online;

10. Import hyperlinks with PDF, include web link, page link, email link.

11. Import text so text is searchable, define the minimum search characters.

12. Add watermarks text, image, dynamic date/ time etc to page-flipping eBooks.
13. Define quality and size for normal version and mobile version.

14. Detect landscape page to present as two-page spread.

15. Publish online directly with using eFlip Upload Service.

16. Output to different formats: HTML, EXE, Zip, Mac App, Mobile version and
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17.
18.
19.
20.
21.

22.
23.
24,
25.

26.

27.

28.

29.

30.
31.

Burn to CD.

o HTML allows you to upload to a website to be viewed online (with title,
keywords and other metadata defined).

o EXE (with setting title, icon and open window size) and Zip allow you to
send to your user by email to be viewed on their computer.

o App (Mac Application) is executable application can be run on Mac.

o Mobile version is to output HTML flipbook which can be viewed on mobile
devices via Browsers (Support slide single pages on mobiles).

o Burn to CD allows you to burn to disk so you can send your user physical
media for viewing on their computer.

Show uploaded books in BookCase with shopping cart integrated.

Apply a pre-designed template and animated scene, more free templates online.
Show Assistant and scrolling tips in your book, and record or embed sound directly.
Preview the output effect instantly.

Add HTML Title in Float template which can be clicked to visit webpage
online.

Add Image or Flash logo to insert before Book Title in Float template.

Define book proportions, thickness, margin size, shadow manually.

Set background color and image.

Insert background music either for continuous play (loop) or for a set
duration.

Set eBook reading from right to left (for Right-to-Left languages such as
Arabic).

Choose hard cover for eBooks.

Set fonts for Flash and Bookmark, Search panel.

Define the language for your published page-flipping eBook (support
multi-language show and switchable).

Add password to protect your page-flipping eBook.

Different kinds of render engine for choice to avoid distortion for some
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32.
33.
34.

35.

36.

37.
38.

39

40.
41.
42.

special PDF files: SWF, GPL Ghostscript or Inner Library.

Google Analytics Support.

Set colors and position (Top/Bottom) for toolbar.

Set permissions for downloading, printing, social sharing, Home button and
more.

Full customize your flip book with your brand, message, logos, sound, colors
and icons, background, and other company/promotion related information.
Add watermark image or SWF to show on print out pages.

Add Help config to manually define content with using Image or SWF.

Set Page Number Box to show at top or bottom in Float, set start page

number.

. Add Single/Double Page view.

Add Minime Style to show page-flipping eBooks without toolbar.
Edit bookmark and set bookmark panel to show on left or right side.

Export and save settings for future uses.

Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

1.

2.

Flip book pages by dragging corner, clicking page shadow, mouse wheel, etc..

Use Previous, Next, First or Last buttons or thumbnails to navigate through the pages.

View with important pages pre-loaded to open quickly, no need to wait for all pages to

be loaded.

Flip pages automatically.

View page-flipping eBook in full screen.

Add annotation text or shapes to highlight.

Print out the whole eBook or a selected range of pages.

Download uploaded page-flipping eBook or other file while reading book.
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9. Double-click to zoom in or zoom out.

10. Share eBook URL via email, Facebook, Twitter, Google, Yahoo, etc.

11. Turn background sound on/off.

12. Open in the Browser to a specific page by adding a page index to your URL. E.G.

www.yourdomain.com/index.html?pagelndex=4.

13. Always show in Minime Style with adding a parameter to URL. E.G.
www.yourdomain.com/index.html?alwaysMinimeStyle=true.

14. View page-flipping eBooks in the browser of Mac, PC, iPad, iPhone and Android devices.

Quick Start

L

-

1. Launch the application via the desktop shortcut = ;

=) Create New

2. Click "Create New" and select template and define project path;

Import Now

3. Select PDF to import and click "Import Now" icon to enter into template

setting interface;
4. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and then click the

"Apply Change" icon ®;
5. Click "Upload Online"! — Upload Online |, nConvert to Flipping Book" E to output
created page-flipping eBook.
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Interfaces

There are some main interfaces you will see while using EFlip Standard
as below shows: Project Panel, Application Options, Import PDF,
Template Settings, Language Option, Output, Upload Online and Batch
Convert. You can enter into each page to get clear instructions for every

detail option.

I. Project Panel

|
= eFlip Standard

Recent Projects Create Rew Online Service
B Froecss
i o L] Create New
W P

Recent Outputs Support
m al|

[T RLERT

Help document Update to Flip PDF Professional
—_—

In the project control panel, you can view and open recent projects and output flipbooks, create
new project or just view demo project. Besides, you can view BookCase Demo, check Online
Service details, get support, view "About" and "Update" info.
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Il. Import PDF Interface

Chick "Create New" to build your own project, select template, define project name and location.

) select Template

My Templates | Online Templates

|
. | | Mewly developed Neat Template provides & stylish and fresh ook for you to design more stunming page-fipping eBooks. In
= & Meat Template, you can add brand loga in the top toolbar, set different featured buttons, show or hide transparent

thumbnails at bottom, enable Social Share via different channels, etc, Neat presentation nterface, neat contral panels and
neat resding manner help to buid your neat feeing publications.
[ Classical
[ calendar - g
=B B e
[E] conciseness
Elack Pattern Blank Light Shadow
[ Flexible
[&] Handy
B . | p—
fuely e

i s Topof e workl. e

O singleside ﬁ: —uz L] SRy

2 Project Name

hame: Project2012

Location:  C:\Jsers\Administrator \Documents Fip PDF) Open

You can select Template and Theme from the list, or go to "Online Templates" panel to download
more templates and themes to use in EFlip Standard. More templates and themes online:
http://www.pageflippdf.com/themes-2012.html

Then click "Next" to enter into PDF Import interface:

& Import PDF

Source PDF Flie

+\Useful Documents\PDEs \Flip POF. pdf| Browse.. | ’ Cpen it
The Page Ranges to Import Watermark

©) Akl pages 2" Place a custom text or image

@ Gustom range: [1-10 Example:1. 35,671 c - Watermark({Stamp) to the file(s)

b e

[¥] Quickly import (Only import 10 pages to initial preview) Set Watermark
Page Quality

Quality And Size: [Medlum quality medium file size - |

A4 High values produce better page quality but require more disk space and more time to download.

[#] Import bookmark [¥] Import links [¥] Enable search [¥] Detect wide pages

(1mportow | [ cencel |
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1. Source PDF File

Click this icon to open the PDF file you want to convert;

m View content of added PDF file to clarify before converting.

i

2. The Page Ranges to Import

|'ET|
@ &l pages Convert all pages to page-flipping eBook;

@) Custo U i2E E 11,3,5,3-21 .
Lo xample:1,3;5, Convert defined range page;

(9] Quicidy import (Orly import 10 pages to ritial previen) Just preview effect on first 10 pages.

3. Watermark

set Watermark Add image or text watermark to flipping pages.

Appring Wabermark Check this option first to choose default stamps or add new ones:

i Add Text Watermark ==
A Add Text Watermark

Text Name
bame:  Text Watermark

Text Page fiorg cBock acre B
TextProperses
gont: (@ pelveses =] [7]Embessed tont

Page-flipping eBook

@]

Edit / Ehlu‘:ﬁ -
Add text stamp foe °l

Add image stamp. i A imege watemsrk

Delete o

Move down : )

> ¢ X 8 &

Move up et

4. Page Quality
There are five types of "Quality And Size":
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Low guality small file size
Lower guality smaller file size

5. Other Options

[} tmport bookmark Check this option to import bookmarks from PDF to use in output eBook;
[l epartits If your PDF file has links, check this to enable in flipbook;
Enable search

Check this option to enable search functionality in created flipbook;

[/Detect wide pages  cpac this option to make landscape page in PDF file to be presented as

two-page spread in output flipbook.
At last, click icon to enter into template setting interface.

lll. Template Settings Interface

| File Convert Options Online Help

[ )
I & Import PDF @ Apply Change a Convert To Flipping Book Upload Online . Manage Online Books

E|_IZ-J-x=_sign Sala Bookmark | Bookmark Tabs | Scs'_' 12

Templates QH‘“’H@M?:D:
LB J] B —

More free online templates here. ..

Search: |

BlTool Bar Settings
[ETitle Ba
... TheBooklogo
Logo URL
r-EEu_tb%ns Bar
.. FullsoeenButton  Ishow
_BlepConfig |
... HelButton
... Help ContentFile  |C:i

sers\ADMINL,, =

Buttons Bar
'Eﬂ. Set button status on the Tool Bar
=

"

[¥] Instant Help 2 THUMBNAILS und On  Social Share iii
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After importing PDF, you will see the main Template Design and Preview interface. Four tabs in
the design panel for you to design template, choose scene, define bookmark and edit content for

assistant.
o [ Scenes | Bookmark | Assistant| | Design setting | E==n=s] | Bookmark | assistant | | Design setting | Scenes |[BooRma] Assistant | | Design Setting | Seenes | Bookmark | [Pesistand |
Templates Double dick to apply scenes, Yaou can setup bookmarks here

& Record &Manage Audio Files ‘

*

IF neat H By BE

=] 2] [+ [E] (2] 61

More free online templates here. .. | -] Chapter 1 Dic (B sty casstant.
~{[E] Chapter 2
- = s Chapter 3
Search:
None Aurora i
FE1Tool Bar Settings | = EEEDE’ :
Flash Display Settings | iy E Cthte: =
Pages thickness Thinner | : " P Nome
B d Alph: i | . | {
ackground Alpha I != » Title:
Retain the book to center | Yes E =
Show Corner Flip Effect | True | Autumn leaves Beach beauty Page: 1
Mouse Tracing Effect | True | =
Open thumbnails pallet False L ¥ = r Input ;‘lﬂiﬁﬁh‘ 3'"3\‘;3(“‘1; :{' m; title fo ql{j_)?f
i i __|} | name booktitle &s "title text” and page as
Button: - -

1. Design Setting

The design setting interface contains below main parts:
Choose Template, Tool Bars Settings, Flash Display Settings and Flash Control Settings.

(1). Choose Template

Templates

‘ If neat j B ¥

Mare free online templates here. ..

Although you have selected template before importing PDF, you can also change to other

X Neat E A A
templates. Just click ‘I‘ icon to select templates from Template Selection

interface, or download Online Templates to use.

BClick this icon is to save current settings as a TXT file for later uses;

Click this icon is to import stored setting file at once.

Download more templates/themes to use:
http://www.pageflippdf.com/themes-2012.html

(2). Tool Bar Settings

[ETool Bar Settings
 ETitle Bar
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i. Title Bar (only in Float and Neat template)

| E|Tt|e Bar _____

| TheBookloga  |C:Wsers\Admin..
|  logouRL |http: f/fiipbuilder ..
i Bu:unk'l'ﬁe <a href="http://. ..
(=

Page Nurntuer Box On .. False _ |

h FLIPBUILDER.COM |

Customize book title and logo for showing on the top of your flipbook. You are enabled to set the

book title as HTML format text. For example: <a href='http://www.pageflippdf.com'
target='_blank'>pageflippdf.COM</a> | <font color="#ff0000' size='14'>Red Color</font>

ii. Buttons Bar

IElButtons Bar

FuII Soeen Butbon |

I HE||:I Cnnﬁg
[HPrint Config

HDownload setting

Bsound
HZoom Config
HSearch

:I Share

_ILanguﬂﬁIE
| [HAuto Flip

Home Button

You can add a home buttonm to help reader to click and go to your website directly:

E|Horne Eluthon )
Home Button Visible Show
P_age URL http:/{flipbuil. ..
Open Window |Blank

Full Screen Button
To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen Button
Full Screen Button Shaw

option:

[

[
Then you can click icon sl to view flipbook in Full Screen, click icon m or "Esc" button

to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, you
set "Full

Full Screen Without Toal. .,

can "No" in Screen without Tool Bar" (just in Classical Template):

Yes

Copyright 2013 by pageflippdf.com
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Help Config
HBlfelpConfig L e
Help Button Show
Help Content File {-type.png =
. Help Window Width 1400
_ Help Window Height 1450
Show Help At First Show

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you can
define Help Content manually by inserting "Help Content File (image or SWF)", also enable to
define the Width and Height of the Help image or swf. If you set "Book->Retain the book to
center->No", you can set "Show Help At First->Show" to display the Help Panel with the Book as

below:

—— 'a_k'é

Help: e o ~  Fuip PDF g

Double-click to room in/room out;
Drag the page cormer or
Use mouse wheel te flip poges.

You can also click the button to view the same Help page in pop-up window.

Print Config

Print Enable |Yes
Print Wartermark File | BES s Ealgl)

Choose "Yes" in "Print Enable", then click icon to set print page range as below:
& Print k 4

= Prmnvt 23 Pa GEs
_ Print Current Page

. Print Range
Example; 2 5,8-26

£, Print
4

You can also click "Print Watermark File->..." button to choose image or SWF file from your
computer as watermark on printed out pages.

Copyright 2013 by pageflippdf.com
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Download Setting
ElDownioad setting .
Download Enable |Yes .
[ Dowrload LRL ADFDema.pdf!

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input Download URL directly like
"http://www.pageflippdf.com/example/files/download/FlipPDFDemo.pdf" or relative path like
"/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the PDF to the same path).

Then readers can click the icon n to download your uploaded PDF file directly.

Sound
ESound ; !
Enable Sound |Enable E
[ Sound File m_]l
Sound Loops 1

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =|" icon to choose "Sound File" from your computer, then
set "Sound Loops", "-1" stands for playing the sound file all the time while viewing flipbook,
other value (N>0) stands for the times of playing the sound file.

Zoom Config
To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

Bzoomconfig 0
...Zoominensble o ves
Zoom Scale 1.5

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by the

Copyright 2013 by pageflippdf.com
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zoom in tool like this: m n You can also set "Scroll with

mouse->Yes" to scroll zoom in page while moving mouse.

Search

| SearchButon  [Show -
. Search Highlight Color | L10xFFFF80
Least search characters |3

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in "Import

PDF" interface), then define "Search Highlight Color", after clicking "Search" icon , you

will see a popup box to input search words, then click Enter or "Search" button, you will get the
below searching result:

_ social Share Button _|Show

a. Share Button (via Email)

If you want readers to share via Email, you can enable "Share" feature as below shows:
E.|.5.h§|re 'Bu.‘.qi:qn'

‘Share Button Show
'Email Subject Rear my fi...
Email Body {link}

When the viewers click the share button E, they will enter into the Email interface with the

link of your flipbook in the Email body.

b. Social Share
If you want your flipbook viewers to send the link to their friends or clients via Facebook, Twitter,
Linkedin, Google, Yahoo and so on, you can add a Social Share button in your flipbook for readers
to send out your flipbook link immediately:
Copyright 2013 by pageflippdf.com
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| Sodal Share Button iShnw |

The readers just need to click the "Social Share" button ﬁ, then the below window will pop up

for them to choose share channel:
Social Share

Microsoft Word - demo3.doox [—_ﬂ Facebook ™ Twitter
in Linkedin Google
B pel.icio.us ‘Yahoo

B Digg [0 StumbleUpon
L live 5 sk

- > .

@ Reddit m Mooc

3 Technorat + More

Link: htep:/fwww flipbuilder.com/flip-pdf/example/

Auto Flip
To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the Flip
Interval (seconds of staying on each page); the value of "Play Count" stands for the times of auto

playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip button “,

the flipbooks will be flipped by staying 3 seconds per page); if you want to auto start and flip the
eBook after opening, just set "Auto flip when start up->Yes":

 ElAuta Fiip
le

Auto flip when startup |Yes

Thumbnail Button
| Thumbnail Button |Enable |

Show Thumbnail Button E(set "Enable") to view page thumbnails of your book, or you can

Disable it to hide the button.

Single Page
[ Single Page |Enable |

If your book contains landscape pages, or the page content is different to read for the font is too

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon n to
view pages one after another, then click "Double Page" icon m to back to the normal book
reading mode.

Copyright 2013 by pageflippdf.com
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| Ellanguage  Engish _
Language 'English;Chini_:_'_'_j:
Switchable _'Yes
You can set language for showing tools or tips in your created flipbook, click "..." to enter into

"Language Settings" interface. You can choose two or more language to use, just check

"Switchable" option, then users can click "Switch Language" button [:]to choose their prefer
language for tips:

Please select a language below...

English

Erench

Add Annotations
To help readers take notes on your books while reading, you can set "Add Annotation->Enable".

When readers view your book on computer, they can click "Add Annotation" iconE to add

text note, highlight pages with brush, draw rectangle or ellipse on anywhere of your book pages.
If they open the book next time, they can view the comments, or delete as they want:

Copyright 2013 by pageflippdf.com
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| WL 15: 1055
L-';| add test note, highight aages with
& gh, draw rectangis or oo on
anpatag of bocis
&
L x| ~ =B
2ok
Elnse
&
o Bordar Width 3 =
| Border Alpha 100% -
@  Boder Coke 27rrn0
o

€ - E R

iii. Tool Bar on Top (only in Float template)

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":

[ 'i_'g:n:nl Ear G:ll'l top [True

iv. Button Icons

Define color for the icons of the buttons:
[ EButton Icors ' il

Icon Color [JowFrrF |
?7 QA = @

(3)- Flash Display Settings

EFIash Displal,r.5ettings
Wi bzt ot
O .
InitalShow ~ |Mome
_Show Comer FipEffect False
EHBackground Config

EMinime Style

Copyright 2013 by pageflippdf.com
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i. Retain the book to center
| Retain the book to center [Yes hd

If you select "No" in this option, the eBook will be shown on the right-side. This setting is for

embedding special background image, such as advertisement or company log.

ii. Pages per thickness (only in Neat template)

To create more real life like ebook, you can set Pages per thickness, which means how many
pages to show a distinguishable thickness. The smaller value set, the thicker your book. If the
value is smaller than 0, or larger than the total page number of your book, it won't show any
thickness. And on the book edge, you will see different page number tips for you to click and go

to that page directly:
R QM MqEDEIH®Q?H

P —— [T S——

iii. Background Alpha

[Background Alpha [l |

Set the value (0-1) of alpha to control the transparence of the background in flip book. For
example, you can set the value as 0 to make the book background as transparent completely,
when you embed the book in other HTML page, it will show the background of that HTML only.

iv. Show Corner Flip Effect
Show the Corner Flip Effect at the beginning to tell readers that they can drag or click the corner

to turn pages directly.

Copyright 2013 by pageflippdf.com
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Show Corner Flip Effect | True

v. Mouse Tracing Effect

Show Mouse Tracing Effect at the beginning to tell readers that they can drag or click the corner
to turn page. If the book is set to open with double page spread, then the Mouse Tracing Effect
won't work.

Mouse Tracing Effect True

vi. Open thumbnails pallet
Define whether the thumbnail pallet open or not when you arrive on the book.

Copyright 2013 by pageflippdf.com
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vii. Font
IR
e
_FontColor [ 1OxffFFf
_ ButtonFont  |Tahoma

_ ETitle and Windows |
. HBookmark

FHSearch

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search result
panel, you can set font types and colors in Font Panel.

viii. Initial Show (set in Float/ Spread templates)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails": Linta show [Thumbris |

Then you will get flipbook shown with below initial interface:

ix. Background Config

Background Color:
BeadgoundConfig [
B T [
_ GradentColor | M0x000000

Gradient Angle |an

/Gradient Color A

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors.

Copyright 2013 by pageflippdf.com
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EBackground Image
Image File
Image pasition

Click the icon "=1" to choose background image from your computer, and there are 11 kinds of
"Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left,
Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

Background Image (set in Float template):

BBackground Image [
Outer Image File E:'Prugrw

Image position Scale to fit
[ inner Image File E:|Program..]
_ Image position |Scale to fit

The Float template enables you to add two background images: Outer Image and Inner Image.
You can make Inner background image to show special information, such as advertisement or
company logo, etc. There are also 11 kinds of "Image Position" for you to choose: Scale to fit, Fill,
Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle Right, Bottom Left, Bottom
Center and Bottom Right.

x. Flash Window Color

| Moxon00~|

Flash Window Color

This color will be applied on all flash windows, such as the book window, "Help" window, "Print"
window and so on.

Copyright 2013 by pageflippdf.com
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xi. Page Background Color

....Page Backgroun

When load pages, or if the page number of your PDF file is odd, then the page (the last page) will

show with the "Page Background Color".

xii. Book Proportions
| BlBoak Proportions |

=\idth—=

Height o
| _____Furror |

Please note that the values are not fixed in pixels or inches, they just represent a ratio for "Page
Width: Page Height", and the book size will be changed depend on your Explorer Window Size.

xiii. Book Margins

Book Margin (set in Classical Template):

" ‘Book Margin |50 |

Margin

"Book Margin" refers to the distance between the book and the toolbar.

Copyright 2013 by pageflippdf.com
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Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

Top t_

=3

xiv. Page Shadow

| BPageshedon |

Lefe page Shadow

Right page Shadow
The value also takes the value of Book Proportions as reference, and the value interval of "Page
Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

xv. Hide Book Frame Bar

| Hide Book Frame Bar |Yes x|

If don’t want to show the book frame bar, choose “Yes” in this option.

xvi. Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in "Right

to Left" option:
| RightTolet T Jves

Copyright 2013 by pageflippdf.com
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xvii. Start on Double Page
Open your book in double-page spread or not. "Yes" means open book without cover, presenting
first two pages at a time. If you have odd number pages, you can set this option as "Yes".

Hello:
Welcome To.
FlipPDF Demo

www [Miphuilder.onm

Start on Double Page Yes

Start on Double Page |No

xviii. Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your flipbook,
choose "Yes" in "Hard Cover" option:

Hard Cover Yes

xix. Flipping time
Fiipping Time 0.6

Sets page flipping time in seconds according to your needs. (Recommended value is 0.6)

xx. Mouse Wheel to Turn page
| Mouse Wheel to Turn Page [¥es
Enable or Disable turning page with mouse wheel.

xxi. Page Number

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". For
example, the first 3 pages are Table of Content pages with Roman page numbers, and set Arabic
page numbers from page 4, then you will get page number box like below:
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_BPageMumber 1
_ StartPage Number Roman) 0
Start Page Mumber {Arabic) |3
Front Cover Page:

The Fourth and Fifth Pages: |

xxii. Minime Style

If you want to present Page-flipping eBook pages directly without showing toolbar, especially
when you want to embed eBook into a small area in existing webpages, then you can use this
"Minime Style". The Minime Style will trigger when the Width or Height of the Flash Container is
less than the defined value. You can also always show the page-flipping eBook in Minime Style
with adding a parameter to your URL like this:
www.yourdomain.com/index.html?alwaysMinimeStyle=true .

IMmmime st

_ UseMinimeStyle ~ |Yes

 Width 400
Height | 300

s Flip PDE Whvy Choose Flip PFTEFY

L T L e * Cramtm ranl Plpping effact book In
Acrzue FOT PRx o1 2 waetppby Berber ol al minute
arrers s b7 B eas rerzang ot Tiilbhg e Wb fe: ceewetca. CmATES R an own
2k ema bo capls Tidkasoen, crid Tegeara mabrc Sdshell ach s faer tnnk e e
il vazhia end man Ve s osoals Lzl n Mo

e ! s 2R T b b
= LA TR ] e O

BRRD A L [ ey A AR Ly D e
Eomd oo bl e 0 e L,

Onetima fms, urlimited canvarchan.
P B8 vy s eEaan wen e e e

o e sndireead PHE hes 10oas
s e Hesee hebe S mnomete o
smzrera e Ty bBakn e

(4). Flash Control Settings

ElFlash Contral Settings

_ SecuritySettings  |NoSecurity

Bllitks ]
Google Analytics ID
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i. Security Settings

[ Security Setlings Single Pass |

If you want to protect your flash books with passwords, you can click "..." icon to enter into

"Flash Security Config" interface:

Hote:
Srgle Paswweord oprtion mesns fhat usess nesd e pessverd B view the flash book

Exciude Front Papes option s to'set a page number, all Iatier papes tan't be:
vimyee= varthout Inpuitng pessword.

Security Tvoe
’ fin Sevurity
1
o
'J"h\ & Tngle Passwond: 123456
Protect Page Range
& Pages |
& Exclude Front Pages ]

o | Qose

Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All Pages"
or the latter pages after a defined page number. (Tips: The program utilize RC4 algorithm to
protect eBook pages, the eBook content pages will show nothing without permission.)

ii. Links

L bmkaipha p—
...Open Window Blank

Enoble after zooming in  Enble |

Greats your professional fipping book with POF files

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers to
the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), and
"Open Window->Blank/ Self". The links also can be clicked after zooming by setting "Enable after
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Zooming in->Enable".

iii. Google Analytics
In the HTML output format, you can add statistics by using google analytics. You can get more

information about Google Analytics ID from http://www.google.com/analytics/ .

2. Scenes Setting

To make your book more attractive and lively, you can apply animated background which
called "Scene" in the flip program. There are many pre-designed scenes for you to choose
and use directly, such as Autumn Leaves, Beach Beauty, Desert, Moon, Underwater World,
Grassland, Snow, Clouds, etc.

The couds The dandeion Th«.snnv\oc. Undiarmater workd
<
k 4 ]
Fiyng Gam Telarnd Sunset
Show The douds The doudsd2 The doudedd

Just double-click to apply the scenes, or you can set your own style scene by setting "SWF"
format background image in "Design Setting" part.

3. Bookmark Editing

You can check "Import Bookmarks" option in Import PDF interface if your PDF contains
bookmarks, or you can edit bookmarks directly in the program. In Classical Template, you
can even define bookmark font color, background color, position, etc.:
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| ElBaokmark |

| Fontioolor W 0000
Background colar 0000 SE AR F i
Backiround aipha 1
Alays Show Bockmark | True
Fanks Position Left

FLir PDF

EaA detup baskmarks harg
ot —
P"' Dl
1] Advargsges
&

b & purchase
Eu,

Title:  Other procucts

Ll LY el —+ |y

Poge: &
4. Assistant Setting

If you want to provide sound or text tips for pages of your books, you can enable the Assistant
Feature, edit scrolling text, record audio or insert sound directly. Then readers can following your
tips, listen to the audio you applied, get more interest and info from your book.
(el QM (NI > @A ? O

£ ecord AManage dudoPles v

Do chk: to apply sssstant,

£ Thumbrals 1D suto B Wi Sound On - Socsl Share ﬁﬁ]

3 Record & Manage Audio Files

Y

Click "Record & Manage Audio Files" icon to enter

into Record Audio interface:
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Record Audio |

[4] Fagel 2 Audio text:

Page 2-3 Hello, my name is Lily. Welcome to our Flip PDF Professional demo project! The =«
a1 Page 45 wonderful Demo will show you rich features of this Professional software, You
ot can follow the tips to create your unigue and attractive page flipping eBooks.
_ Page &6-7
4] Page &9
'5 Page 10-11
[q] Page 12-13 =| -
4] Page 14-15 Audio:
[q] Page 16-17 (@ Generate audio automatically (Text to Speech)
[4] Page 18-19 .

3 Engines! ICEpsh'aI Allison vJ | o7 Generate audio
¢ Page 20-21
4] Page 22-23 (71 Import audio from existing file
‘W] Page 2425 | EI—
Flay audio 0:00] | | [o:
Page 26-27 |—¥ i ! i:35]
About record audio l Option ‘ I Apply l

Input "Audio Text" for each page, and then choose Text-to-Speech engine, and then click
"Generate audio". After generating, you can click "Play audio" to listen to the audio, you can
also choose "Import audio from existing file" to apply existing audio directly.

About Text-to-Speech engine install and use, you can view details in this page:
http://www.pageflippdf.com/faq/How-to-read-your-text-to-readers-in-flipping-book.html

5. Other Settings

(1). Export Theme

If you want to save the current template settings as your own style template for later uses, you
can click "File->Export current settings as Theme" button to storing all current template settings,
include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added to
the templates selecting interface. Download more themes from eFlip now:
http://www.pageflippdf.com/themes-2012.html

(2). Application Options

i. Render Engine Option
EFlip Standard Pro provides 3 different render engines for you to create higher quality
page-flipping eBooks, click "Options->Application Options" to enter into "Render Engine"
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interface: SWF: Much legible characters, smaller output size; GPL Ghostscript: Higher color
transfer quality; Inner Library: Faster convert speed (change option when PDF imported failed).

ii. Create Mobile Version Option

Pages Quality and Size
Five types of "Pages Quality And Size" for mobile version eBooks:

| Pages Quality and Size

Quality And Size:

High quality large file size
Medium guality medium file size
Low quality small file size
Lower quality smaller file size

High values ¢

a4, but require m

Mobile Template
The current version provides two mobile template modes for you to use: Slide and Single Page
Flip. The later one adds page-flipping effect on the pages while viewing in mobiles.

ﬂ Apply Change

At last, click icon to apply the settings.

IV. Language Options Interface

Click "Option->Flash Language" or "..." button beside Language setting part, you will enter
into the Language Settings interface as below shows:

[ L;inguage .S.E.t‘.tl-"gj ]
You can edit current language file or add a new language to display your page-fiipping eBook, twe or mare languages can be
used at the same time. Readers then can dick "Change Language” button to view the eBook in their prefer language.
= The first checked language on the top of the "Languages” list will be taken as the default language to show your flip book. You
v can also define a language to the published flipping-book by spedifying with the address like:
http:f fwww. somedomain, com/mybook, himi?pageIndex=4&ang=Japanese
Lauangues ] |
English Q Save as... -_:;J Load... J Q Edit ‘
Chinese ~Language Settings
[ Arabic
0 Frenh Label | Labeled [ -
First Button First (|
[ serman Mext Page Button Mext Page |
[] Greek Last Button Last =
Previous Page Button Previous Page |
[ Hebrew Download Button Download
[ Italian Print Button Print =
Search Button Search
[ Japanese Book Mark Button Book Mark
[] Portugues Help Button Help
Enable FullScreen Button Enable FulScreen
Disable FullScreen Button Disable FullScreen
Sound On Button Sound On
Sound Off Button Sound Off
Share Button Share
Social Share Button Social Share
Zoom In Button Zoom In
Zoom Out Button Zoom Out
|| | Auto Fiip Button Auta Flip =
2 X 4 ¥
o |
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As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you 10 different languages for you to use:
English, Chinese, Arabic, French, German, Greek, Hebrew, Italian, Japanese and Portuguese.
You can also add other language for your own uses:

1. Click the button % and define name for the new language:

i E- MNew Language ﬁw
New Language |
[dame: French
Copy From: Englsh -
(S =

Click "OK" to save the new language in the list;
2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":

Language Setings
hext Page Buttan Pext L
Last Butten Last I Editi Language Item i
Prévious Page Button Prévigus P ———————
Devrload Buttan Donlasd || EOtLERuRge String
Print Buttan Print
Search Butten Search Label | First Button
Baek Mark Bulton Boak Mark ’
Hep hitton ielp \sbeled:  Preswire]
Enable FulSereen Button Enahls Fulls
Drsabie FullSoresn Button Dsable Fuil
| Snemd Om Bt Fraepr |
[ Save And Edit Hext l | Cancel -
==

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

MNext Page Button

Last Button

Prewvious Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button
Disable FullScreen Button

St e T B

Labled

Premiére

Page suivante
Dernigre

Page précédente
Telécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer Fullscreen

Désactiver Fullscreen
La S

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33l Load...
Load language file saving before for current using:
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ﬂ Apply Change
After setting language, click icon to apply settings.

V. Upload Online

To make it easier for you to publish your created flip page books online, we developed the
Upload Online Service. By using this service, you can upload your book online instantly after
creating it, with no FTP or other upload tool needed. You can easily manage your books, and
make it easy for people to view your books online in their browser on their PC, Mac, iPhone, iPad
and Android devices.

After designing your book style, you can click "Upload Online" button .m Q'ﬂ“do"m.t

upload your book onto eFlip website server directly. Upload the books to eflip server, just need 3
steps: Sign up, login your account, upload your books.

1. Sign Up
Create your account to use the Upload Service easily:
i Login ]

Sign up and start sharing your flip books online
@ Create new account

Email:

Password:

1 Use an existing account

| Create || Cancel

2. Login Account
After registration successful, you will login automatically.

3. Upload Your Book

After login your account, just input your book HTML title and then click "Publish Now" to
upload your created book. You can also define Description and create mobile version in
"More":
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5 Upload the book e e
Book settings

HTML Meta Settings

Title: FlipPDF

Description!  convert pdf to page-flipping ebooks to publish orline easily, with background image,
sound, book thidness effect added
[¥] Also Make Mobile Version.Please select a template for mobile: Single Page Fip =

[T override an gxisted book:

After uploading successfully, you can use the Book URL to share with others online, or

through social share websites, or copy the Embed Code to insert into webpages in "Book
Information" panel, etc.

| BookurL: hitp:/ /t.flipbuilder.com/Ibse [ cycw/

[ Copy ] I View Now

B Send email ‘ =5 Social share I & Lrserttnsﬂ:e‘

Send to
(For exampie: guest I@Gmad. com;guestZ28Gmad. com) [:]
Fram Subject
(For example: your name or company) (Mo subject)
|

Message

(vour comments)

Manage my books I I OK I

o) Maﬂge&ﬁrmﬁuuks!
You can click "Manage Online Books" button ‘ = in main process

interface to manage your uploaded in below window:

E = Publcations ! Hige 8 oelets | . vl to Collection| @Q Refresh Booklist géau.:h
@ Public Sharing = :
|| (@ protected Sharing Bt Creste Time State

& My Collections T
12 Pages:28 | Size:36.6MB | 2012-11-06 15:07:33 | Startup
http: /it fipbuilder, com lbsejoyon/

Points:

a Purchase One point can be used to enable 5 book to FlipBuilder Server in one month
Total books: Select1/1

LUised Disk Space:
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In the book manage window, you can check your publications, share them with others, edit
book info, hide your book to prevent other people from reading your book, even delete it if
you want to edit again.

VI. BookCase

eFlip Standard BookCase integrated in EFlip Standard will be the best tool to help you
build digital library to store and manage eBooks. All books you published on eFlip
Server or some other place online can be collected and shown in your bookcase, you
can easy manage and share the books via using the wonderful and realistic BookCase
tool.

B 0 B 1010 P PO o B ... TEEE. 0 W s e

B Oeiea Ml
% =]

0 T S | P aery

More details about how to use and design BookCase here:
http://www.pageflippdf.com/faqg/flipbook-bookshelf.html

VIl. Output Interface

Click "Convert to Flipping Book" to enter into output interface:
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iDu‘lputOp{lon . = @ 2
| 2utput |
QOutput type

- -
{ @ =] = = o e B a-
3 @ = html = o) *.4p {&1! 7 *exe “, ~)*.app
[¥] Also Make Mobile Version  Make output page-fiipping eBook works on iPad, iPhone and Android mobile devices
Path

Output Folder: Ct\sers\Administrator\Desktop Browse... H Open

File Hame: index .html

Options
HTML Title: Microsoft Word - demo3.docx {4 Advanced

[CIBumn to co

=r|0:1:0,G: PLDS  DVD-ROM DH-16055 VD15

Make it automatically play the fipbook in CD

1. HTML

P oo

This output type is for uploading created page-flipping ebook onto websites. You can define
HTML Title and other properties by clicking "Advanced" button. Set Keywords, Description or
even Script in the below interface:

[ Advanced Settings =

HTML Advanced Settings |

HTML Meta Settings

Title: demo |

Keywords:  pdf, flipbook, page-fipping, eboak, online, website, flash, badkground, music

Description:  This page-fipping anok_ﬁuws you the stunning flash affect on PDF pages, a

Add Saipts
‘You can put some tracking
code sudh a5 Google
Analytics here,
Meed dosed <saript>tag)
(o] |

=l % @ *zp

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by
clicking "Advanced" icon. Your recipients just need to uncompress the ZIP file and then they
can view the HTML flipbook instantly:
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files

Uncompress

3. EXE

a“é;% @ *.gxe

Edemu.html

buuk.swf

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

<=

demao.exe

You can also define Icon and Opening Window Size in Advanced Settings:

J§ Advanced Settings

o]

Exe Advanced Settings
Exe Window Info

Caption; dema
Teom: d!ﬂ. o | | pefmar |

Window Size Option

&) Maimized Custom Size

& Full Soreen

T

If you want to make executable application to run on Mac devices, you can output as

"* app" format.

5. Mobile Version

| [¥] Also Maks Mobile Version

You can even output Mobile Version while choosing HTML or ZIP format at the same time.

After creating mobile versions, you just need to output all files online (including HTML, SWF,

"files" and "mobile" folders), then you can visit the flipbook page through your mobile

browser.
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6. Burn to CD

[¥]Bucn to €D

CD Writer |D: 1:0,G: PLDS  DVD-ROM DH-16D55 VD15«

Disc title: |Page-Flipping eBook

After choosing output type, check option "Burn to CD", set "CD Writer", define "Disc title".

"How to make created eBooks available for others online", view details in this support page:
http://www.pageflippdf.com/fag/how-to-share-my-flipbook-online.html

At last click button to output flipbook in your defined type.

VIll. Batch Convert Interface

Click "Convert->Batch Convert" to enter into batch process interface:

| ©i Add PDF Documents

| g addFles || Add Folder Fenve U Clear Al

|| Mame Path
:Fiip FOF E:\Useful Documents|PDFs\Flip PDF.pdf
= Flip Word E:Wseful Documents\PDFs\Flip Word.pdf
SnFlip PPT E:\Useful Documents'\PDFs\Flip PPT.pdf

A Settings

g5 ! PDF Settings |

Qutput type

o . M B -
@ @ *himl = 5 *.zp F&E‘] O *exe “, ) =.app

[¥] Also Make Mobile Version  Make output page-fipping eBook works on iPad, iPhone and Android mobile devices

Path
Output Folder: Ci\Jsers\Administrator\Desktop\flipbook Browse... ‘ Open
File Mame: {PDF FileName} - html
Flip PDF
Options
HTML Title: My FlipBook - {ig Advanced
My FlipBook

[ Merge All POF Files to One FipBook

/<) Convert to Flash

-
_,,I Convert to Flash

1. Add PDF Documents
s Add Fies ;

Click this icon to add PDF files from computer;
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ij:,ga]AddEcldEfl . . L .
[EE Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

x Remaove aﬁ Clear all -@ Move Lip % Move Down

2. Settings
(1). Output Settings

i. Choose Output Type
Output type

= P = i =
/'3 @ * html = ) *2p @\_ﬁ:! ) *.exe i, ) *.app

[¥] Also Make Maobile Version  Make output page-flipping eBoak works on iPad, iPhone and Android mabile devices

ii. Choose Output Path

Path

Quitput Folder: ;::'-.Llsers'-,&.dminist'abar'vpesktop I [ Browse. .. H Open ]

You can also define output name pattern with FileName, Title, Subject and so on:

File Name: x|

{PDF Title}
{PDF Subject}

FDF Author l
.

And after defining the File Name, you can preview the result example below:

File Mame: {PDF FileName} Flipping Book

Flip POF Flipping Book

iii. Define Output Option
Options

Caption:  {PDF FileMame} - |“h Advanced

Flip PDF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:
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B Advanced Setiings B & dvanced Settings bt
HTHL Advanced Settngs Exe Advanced Settngs |
1T M dcieoor Exe Window Info
o i Caption: demo
Kevwords:  pdf, foback, page-Roong, ebock, orling, website, flash, background, musc .
Descrpton: s page-fipprg eBack shams you the sturning flash effect on POF pages, & o B0 (o] [Lnemn |
Add Soiph Window Suze Cobon
:&c&ﬂmmm [Mawmeped Cystom Size
wm@;w B Full Sareen
[ ] [Csmel | e ] [omes |

iv. Merge All PDF Files to One Flip Book

[#13erge All POF Files to One FlipBook:

(2). PDF Settings

i. Page Range

The Page Ranges to Import

%) All pages

Example: 1,9-21,30
You can convert "All pages" or just "Custom range";

ii. Watermark

Watermark

'!-‘ .4 Place a custom text or image
” Watermark{Stamp) to the file{s)
-z

Click "Set Watermark" icon to enter into "Watermark" interface:

Option - w
Watermark |
] Applying Watermark
Watermark Name Type e~
V&
[Z] A Text-FinaL Text =
o 1 A Text - compieTeD Text i
[T] A Text-DRAFT Text
I| [T A Text-FOR PUBLIC RELEASE Text &
W 1 A Text - INFORMATION GMLY Text =
[Z] A Text - NOT FOR PUBLIC RELEASE Text
71 A Text -noT apPROVED Text 3% |
1 = i
I I A Text - Company(Tie) Text
[ A Text -LOGO eft-top) Text 3 F
[7] A Text -LOGO (Right-Top) Text
[7] A Text -LOGO (Left-Battom) Text -
[T] A Text - LOGO (Right-Bottom) Text
[7] A Text - Dynamic - (tite) Text
! [T] = image -LOGO image |
i Lo | [ cme |

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
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Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

fiah @ualiyiaroe filesize &
Higher quality larger file size

High guality large file -
Medium guality medium file size
Low guality small file size
Lower guality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

Wit bockanant If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

[Vimpart finks If your PDF file has links, check this to enable in flipbook;

G Enetle: st Check this option to enable search functionality in created flipbook.

3. Convert

Convert to Flash

r

Click icon to batch convert listed files together.

License Agreements

All copyrights to EFlip Standard (the Software) are exclusively owned by pageflippdf.com. For
more information, visit our website at www.pageflippdf.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.
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THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.

How to Order

Order Online (http://www.pageflippdf.com/pageflip-pdf-to-flash/index.html) or Order Toll Free

1-877-353-7297 (When you order toll free just give the operator the product number of the
product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:
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If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at http://support.pageflippdf.com/open.php

Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you don't get a satisfying solution, please
contact support team for help.

1. Frequently Asked Questions
You can find answers to questions about technique issues here:
http://www.pageflippdf.com/fag.html

2. Learn tutorial about EFlip Standard

We publish a video tutorial which shows you the easy procedure of dealing with EFlip
Standard, you can view this video to quickly handle the stunning tool:
http://www.youtube.com/watch?v=00TAtCqg3cel&feature=player embedded

3. Get lost license code
Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
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order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us
If you have other questions or requirements, contact us directly through our support Email:
support@PageFlipPDF.com(, we will respond you ASAP.
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